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Overview 

Task Objectives 

The contact force between the tire and the ground is very important when analyzing the 

behavior of a running vehicle. It is difficult to express the tire contact force as general contact 

because friction, slip, and others arising from various dynamic loads must be considered. 

RecurDyn offers UIs and several types of Tire Solvers to easily define the contact force 

between the tires and the ground. 

In this tutorial, you will learn how to create a UA-Tire-type tire using the GTire Toolkit. The 

GTire Toolkit allows you to easily create and define the geometries of tires and wheels, and 

you can easily change several types of Tire Solvers. 

The model used in this tutorial is a front wheel drive model with the Macpherson Strut 

Suspension structure, which is configured to check the dynamic characteristics of the vehicle 

when the J-Turn is performed by changing the steering angle during driving. 

 

▪ Vehicle modeling by importing CAD and subsystem files 

▪ Create GTire of GRoad- and UA-Tire-type 

▪ Analysis of driving by P control and Steering control 

▪ Tire Property modification and result analysis 

▪  

  

Chapter 

1 
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Prerequisites 

This tutorial is for users familiar with Basic Tutorial provided by RecurDyn. Therefore, in order 

to use this tutorial, it is necessary to understand the above mentioned textbook first to 

improve the understanding of this tutorial.  

Task 

This tutorial consists of the following steps, and the time required is shown in the following 

table. 

 

Tasks  Time (min.) 

Setting up the simulation environment 5 

Vehicle modeling 15 

Analysis of driving 20 

Modification and analysis of Tire Property 10 

Change and analysis of GRoad 10 

Total 60 

 

Estimated Time to Complete this Task 

75 minutes 
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Setting up the simulation 

environment 

Task Objectives 

Set Unit, Gravity, and Icon Size to run the simulation. 

 

Estimated Time to complete this task 

5 minutes 

  

Chapter 

2 
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Start RecurDyn 

Creating a new model 

1. Double-click the RecurDyn icon on the 

desktop.  

2. RecurDyn runs and the Start RecurDyn 

dialog box appears. 

3. In the Name field, enter the name of the 

model as Driving_Test. 

4. Set the Unit to MMKS. 

5. Set Gravity to –Z. 

6. Click OK. 

 

Resizing icons and markers 

Adjust the size of icons and markers to make the model more visible. 

Changing the size of icons and markers 

7. On the View Control toolbar, click Icon Control. 

8. Icon Control dialog box appears.  

9. Set Icon Size and Marker Size to 20. 

10. Close Icon Control dialog box. 
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Vehicle modeling 

Task Objectives 

Vehicle's CAD files and subsystem files are imported to define the chassis and suspension, 

and GRoad and GTire are created to complete the vehicle modeling. 

 

Try the following modeling. 

▪ Import CAD files to create Chassis Body 

▪ Import subsystem files to create Suspension 

▪ Create GRoad by using Box Geometry 

▪ Creating GTire of UA-Tire type 

Estimated Time to complete this task 
15 minutes 
  

Chapter 

3 
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Creation of Chassis Body 

 Creating Chassis Geometry 

1. To enter the Edit mode of the Body, click General in the Marker and Body group on 

the Professional tab. 

▪ Body1@Driving_Test is displayed in the 

upper left corner of the Working Window as 

shown on the right. 

 

2. In the File menu, click Import.  

3. Set Files of type to ParaSolid File (*.x_t,*.x_b …). 

4. Select the Chassis.x_t file in the GTire tutorial folder. (File path: <InstallDir> /Help 

/Tutorial/Toolkit/Tire/DrivingJTurn/Chassis.x_t) 

5. Click the Open button. The CAD Import Options window appears. Clear the 

Assembly Hierarchy checkbox and click the Import button. 

 

6. The message window displays a message that the import has been successfully 

completed, and the Chassis is shown as follows. 

 

7. Click Exit on the Geometry tab to exit the Body Edit mode.  
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Changing the property of Body1 

1. Open the property dialog box for Body1. 

2. Click the General tab and make the following 

changes. 

▪ Name: Chassis 

▪ Layer: 2 

 

 

 

 

 

 

3. Click the Graphic Property tab.  

4. Check Apply Transparency for All Graphics 

belong to Body and change the Transparency 

Level as shown on the right.  

 

 

 

 

5. Click the Body tab.  

6. The material input data of Chassis is very 

important in vehicle analysis. Therefore, it is 

necessary to apply it to the body property 

based on the experimental measurement value 

or the reliable data. 

7. Change the Material Input Type to User 

Input and change the information as shown 

below. 

▪ Mass: 1500 

▪ Ixx: 300000000 

▪ Iyy: 2400000000 

▪ Izz: 2550000000 

▪ Ixy: 0 

▪ Iyz: 0 

▪ Izx: 10000000 
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8. Click Apply to apply the User Input status.  

9. If you do not apply the User Input status, 

Center Marker cannot be modified. 

10. Click CM to open the property dialog box of 

Center Marker.   

 

11. In the Property dialog box of the CM, change 

Origin to -900, 0, 300 and click OK. 

12. Click OK of the property dialog box of body to 

apply changes. 

 

 

13. Chassis is shown as below.  

  

Center Marker 
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Creation of Suspension Subsystem 

Loading Suspension Subsystem 

1. In the File menu, click Import.  

2. Set Files of type to RecurDyn Subsystem File (*.rdsb). 

3. Select the Suspension.rdsb file in the GTire tutorial folder. (File path: <InstallDir> 

/Help /Tutorial/Toolkit/Tire/DrivingJTurn/Suspension.rdsb) 

4. Click Open to open the Import Subsystem dialog box. 

5. Click OK. 

 

 

 

6. A subsystem called Suspension is created in the database and Suspension appears 

inside the chassis as shown below.  

 

7. When entering the Suspension Subsystem from the database, it is divided into four 

subsystems in front, back, left and right. 
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8. Again, if you enter one of the four Suspension subsystems in the Database, you will 

see that the MBD modeling of each element is finally done. 

 

9. Once the subsystem analysis is complete, click Exit on the Professional tab to go to 

the top level. 

 

Changing Subsystem Mother Body 

1. Open the property dialog box for 

Suspension Subsystem. 

2. On the Subsystem tab, change 

Mother Body to Chassis. 

3. Click OK.  

 

Entities shown in the figure below are modeled with Mother Body in Subsystem. In the 

above, the mother body is changed to the chassis, and the connection between the entities 

and Chassis is defined. In other words, you can see that Suspension is modeled with 

Chassis. 

  

Fixed Joint 

Bushing Force 

Bushing Force 
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Create Translate Joint for Steering 

There is no modeling of the steering in the Suspension Subsystem. Create a Translate Joint 

between Chassis and RackBar to configure the Steering System. 

Creating Translate Joint 

1. Since you need to click the RackBar hidden in the chassis, open the Layer Settings 

dialog box in advance. 

2. On the Professional tab, click Translate in the Joint group. 

3. Set the Creation Method to Body, Body, Point, Direction. 

4. In the Working Window, click Chassis as the first Body. 

5. In order to click the RackBar hidden in the Chassis, 

uncheck On of Layer 2 in the Layer Settings dialog box. 

 

 

 

 

 

6. To click the RackBar in the Subsystem as 

the second Body, hold down the Shift key 

and click 

Steering_RackBar@Suspension as 

shown on the right.  

7. When two bodies are selected, enter the 

remaining two values as shown below. 

▪ Point: -216, 0, 176 

▪ Direction: 0, 1, 0  

 

 

8. Once TraJoint1 is created, place a check mark in On of 

Layer2 again in the Layer Settings dialog box and click 

Close to close the dialog box. 

 

 

 

 

 

9. Open the Property dialog box for TraJoint1 and change the Name to Tra_Steering. 

  

+ Shift Key 
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Entering Motion in the Translate Joint 

There must be no movement in the steering system to drive the vehicle straight ahead. 

Define the Expression so that there is no motion and enter it into the Motion of the Translate 

Joint. 

1. Open the property dialog box for Tra_Steering. 

2. On the Joint tab, click Include Motion. 

3. Click Motion to open the Motion dialog 

box. 

4. Set the Type to Displacement(Time) 

and click EL.  

 

5. When the Expression List dialog box appears, click Create to open the dialog box. 

 

6. When the Expression dialog box appears, enter as follows: 

▪ Name: Ex_Steering_RackBar_mm 

▪ Content: 0 

7. In the Expression dialog box, click OK. 

 

8. When the Expression List dialog box appears 

again, activate Ex_Steering_RackBar_mm 

in the list and click OK.  

 

9. Make sure that Expression is entered in the Motion 

dialog box as shown in the figure on the right and 

click OK.  

 

10. Click OK in the Tra_Steering's Property dialog 

box. 

 

 

11. As shown in the figure on the right, Motion is 

displayed on the Translate Joint. 
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Creation of Rotational Axial Force for Power 

Create a Rotational Axial Force on both WheelHubs of the front Suspension to represent 

the power of the front wheel drive vehicle. Create a rotational axial force by using Revolute 

Joint located between Knuckle and WheelHub already defined in Suspension Subsystem. 

Creation of Rotational Axial Force 

1. On the Professional tab, click Rot.Axial in the Force group. 

2. Set the Creation Method to Joint. 

3. To create the right front wheel power, hold down the Shift key and click 

Rev_Knuckle__WheelHub@Suspension_FR@Suspension at the center of 

WheelHub in the right subsystem. 

 

4. On the Professional tab, click Rot.Axial again in the Force group. 

5. Set the Creation Method to Joint. 

6. To create the left front wheel power, hold down the Shift key and click 

Rev_Knuckle__WheelHub@Suspension_FL@Suspension at the center of 

WheelHub in the left subsystem. 

  

7. Open the Property dialog box for RotationalAxial1 and change the Name to 

Rot_Torque_FR. 

8. Open the Property dialog box for RotationalAxial2 and change the Name to 

Rot_Torque_FL. 

 

To save the model 

▪ Basic vehicle modeling has been completed. On the File menu, click Save to save the 

model. 

 

  

+ Shift Key 
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Creation of GRoad 

GTire’s Contact requires the definition of Groad unlike the general Contact entities. 

Creating Box Geometry for creation of GRoad 

1. To enter the Edit mode of the Ground, click Ground in the Marker and Body group on 

the Professional tab. 

2. When you enter Ground Edit mode, it will appear as Ground@Driving_Test in the 

upper left corner of the Working Window. 

3. Click Box in the Marker and Geometry group on the Ground tab. 

4. Set the Creation Method to Point, Point and enter as follows: 

▪ Point: -5000, 5000, -170 

▪ Point: 80000, -50000, -1000 

5. Box1 will be created as shown below. 

 

Creating GRoad 

1. Click GRFace in the Road Data group on the Ground tab, and type as below. 

▪ Face: Box1.Face1 

▪ Direction: 0, 0, 1 (Normal Vector) 

▪ Direction: 1, 0, 0 (Heading Vector) 

2. When the Save As dialog box appears, save the GRoad.rdf file in the path where the 

model is saved. 

3. GRoad1 will be created as shown below. 

 

4. Click Exit on the Ground tab to exit the Ground Edit mode.  

 



D R I V I N G  J - T U R N  ( T I R E )  

18 

 

Creation of GTire 

Solver types supported by GTire include UA-Tire, MF-Tire, F-Tire, etc. This tutorial uses the 

UA-Tire type, which is intuitive and easy to use. 

Copying UA-Tire type Tire file 

▪ Copy the UATire_MMKS.tir file from the GTire tutorial folder and paste it into where the 

model is saved. (File path: <InstallDir> 

/Help/Tutorial/Toolkit/Tire/DrivingJTurn/UATire_MMKS.tir) 

▪ The example files used in this tutorial are defined for the UA-Tire Solver specification. The 

UA-Tire file configuration is as follows. 

 

  

Unit 

Solver Type 

Tire Feature 

Contact Parameter 
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Creating GTire 

1. Click GTire in the Toolkit group on the Toolkit tab. 

2. Set Creation Method to Point, WithDialog, and enter 0, -800, 150 for Point. 

3. When the GTireGroup dialog box appears, 

click ‘…’. 

4. When the Open dialog box appears, link the 

UATire_MMKS.tir file copied above. 

5. When connected, geometry information such as 

Tire Radius and Tire Width is automatically 

updated. 

6. Click R to select Road. 

7. Select Ground.GRoad1 created above. 

8. Change the Force display to Action.  

9. Click OK. 

10. GTireGroup1 is created in the database. 

11. Open the Property dialog box for GTireGroup1 

and change the Name to GTire_FR. 

 

 

 

 

12. Repeat steps 2-10 by using the information 

below. 

▪ Point: 0, 800, 150 

▪ Name: GTire_FL 

 

▪ Point: -2746.8298265481, -800, 150 

▪ Name: GTire_RR 

 

▪ Point: -2746.8298265481, 800, 150 

▪ Name: GTire_RL 
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You must constrain the four GTires created above to each WheelHub with a Fixed Joint. 

 

Creating a Fixed Joint between GTire and WheelHub 

1. In the Working Plane Toolbar, select Change to XY. 

2. In order to zoom in only vehicle, multi-select the every GTire entities 

in Database and click Fit in the View Control Toolbar. 

 

 

 

 

3. In order to click WheelHub hidden in the Chassis, 

uncheck On of Layer 2 in the Layer Settings dialog 

box. 

4. Then it looks like the picture below. 

 

5. On the Professional tab, click Fixed in the Joint group. 

6. Set the Creation Method to Body, Body, Point. 

7. To click the WheelHub in the Subsystem as the first Body, hold down the Shift key and 

click WheelHub@Suspension_FR@Suspension as shown below. 

 

8. Select GTire_FRBody as the second Body. 

9. Enter 0, -800, 150 as the Point. 
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10. Open the Property dialog box for the created Fixed1 and change the Name to 

Fix_GTire_FR. 

11. Repeat steps 3-8 by using the information below. 

▪ Body: WheelHub@Suspension_FL@Suspension 

▪ Body: GTire_FLBody 

▪ Point: 0, 800, 150 

▪ Name: Fix_GTire_FL 

 

▪ Body: WheelHub@Suspension_RR@Suspension 

▪ Body: GTire_RRBody 

▪ Point: -2746.8298265481, -800, 150 

▪ Name: Fix_GTire_RR 

 

▪ Body: WheelHub@Suspension_RL@Suspension 

▪ Body: GTire_RLBody 

▪ Point: -2746.8298265481, 800, 150 

▪ Name: Fix_GTire_RL 

 

▪ Once four Fixed Joints are created, place a check mark in 

On of Layer2 again in the Layer Settings dialog box and 

click Close to close the dialog box. 

 

 

 

 

 

To save the model 

▪ From Road to Tire, all the modeling required for the analysis is complete. On the File 

menu, click Save to save the model. 
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Analysis of driving 

Task Objectives 

Use the completed vehicle model to perform the following analysis of driving. 

 

▪ Implement the analysis of vehicle landing 

▪ Perform analysis on straight driving 

▪ Analyze J-Turn driving 

Estimated Time to complete this task 

20 minutes 

  

Chapter 

4 
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Preparation for the analysis of driving 

Define the Torque for generating a driving speed of the vehicle as a spline curve and 

implement it as Expression. Then use the Expression created to apply it to the two Rotational 

Axial Forces created in Chapter 3.  

Define the Torque of running speed as Spline 

1. On the SubEntity tab, click Spline in the Expression group. 

2. When the Spline List dialog box appears, click Create. 

3. When the Spline dialog box appears, click Add Row and enter the values below. 

▪ Name: Sp_Torque_kmph_Nmm 

▪ Data:  

No X Y1 

1 0 1260000 

2 25 840000 

3 50 630000 

4 75 525000 

5 100 462000 

6 125 420000 

7 150 378000 

8 175 357000 

9 200 336000 

10 225 325500 

4. The above information is the torque (N*mm) that each wheel receives relative to the 

vehicle speed (km/h).  

 

5. Click OK. 

6. Click OK in the Spline List dialog box. 

 

The target speed (km/h) is defined as PV for easy speed control. 

Defining PV 

1. On the SubEntity tab, click PV in the Parameter group. 

2. When the PV List dialog box appears, click Add to define the values below.  

▪ InputV_kmph: 0 

3. Click OK. 
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Creating Reference Marker to measure vehicle speed 

1. In the Working Plane Toolbar, select Change to XY. 

2. In order to zoom in only vehicle, multi-select the every GTire entities in Database and 

click Fit in the View Control Toolbar. 

3. On the Professional tab, click Marker in the Marker and Body group. 

4. Set the Creation Method to Body, Point, and enter as follows: 

▪ Body: Ground 

▪ Point: -1400, 0, 540 

5. Repeat steps 3 by using the information below. 

▪ Body: Chassis 

▪ Point: -1400, 0, 540 

6. Two markers are created in the center of the chassis as shown below. 

 

7. In Database, select the Marker last created from the Markers under Ground and open 

the Property dialog box. 

8. Go to the Origin & Orientation tab and make sure the same information as below is 

entered. 

▪ Origin: -1400, 0, 540  

▪ Orientation: 0, 0 ,0 

 

9. Since it is a marker which will be used as a reference marker, please note that the 

analysis result may vary greatly depending on the origin and orientation. 

10. After confirming that the Property values are OK, change the Name to VM in the 

General tab. 

11. Click OK. 
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12. Repeat steps 6-8 for the markers of Chassis.  
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Defining Torque Expression 

1. On the SubEntity tab, click Expression in the Expression group. 

2. When the Expression List dialog box appears, click Create to open the dialog box. 

3. When the Expression dialog box appears, enter as follows: 

▪ Name: Ex_Torque_Nmm 

▪ Content: 

▪ AKISPL( ABS( ( VX( 1, 2, 1 )/1000*3.6 ) ), 0, 3, 0 )*MIN( 1.0, ( 

InputV_kmph-VX( 1, 2, 1 )/1000*3.6 )*1.4 )  

▪ Argument : 

▪ ID1: Chassis.VM 

▪ ID2: Ground.VM 

▪ ID3: Sp_Torque_kmph_Nmm 

 

4. The detailed look at the configuration of Expression defined above is as follows.  

▪ The AKISPL function returns the torque value using the spline information defined 

above. 

▪ Use spline's X value for the VX function to input the vehicle's travelling direction 

speed. 

▪ The vehicle speed is converted to km/h and an absolute value is taken by the ABS 

function. 

▪ Multiply the gap between the input velocity and the current speed by the Gain 

value (1.4) to implement a simple P control. (The gain value can be changed 

depending on situations.) 

▪ Use the MIN function so that the P control syntax does not exceed 1. 

5. Click OK in the Expression dialog box. 

6. Click OK in the Expression List dialog box. 

Enter the Expression you created above in the two Rotational Axial Forces. 
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Entering Torque Expression 

1. Open the Property dialog box of Rot_Torque_FR in the database. 

2. Click EL. 

3. When the Expression List dialog box 

appears, activate Ex_Torque_Nmm in 

the list and click OK. 

 

 

4. Make sure that Expression is entered on the 

Property dialog box of Rot_Torque_FR and 

click OK.  

 

 

 

 

5. Open the Property dialog box of Rot_Torque_FL in the database, and repeat steps 1-4. 
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Implement the analysis of vehicle’s settling on the road 

Run Dynamic/Kinematic to see if the created vehicle is duly settled the road. 

Implement the analysis of vehicle landing 

1. In the Simulation Type group on the Analysis tab, click Dyn/Kin to open the 

Dynamic/Kinematic dialog box. 

2. On the General tab, values are defined as follows.  

▪ End Time: 5 

▪ Step: 100 

3. On the Parameter tab, change the Maximum Time Step to 1.e-3. 

4. Click Simulate to proceed with the analysis.  

5. In the Animation Control group on the Anaylsis tab, click Force Display Setting. 

6. Change the Scale of Force and Torque to 0.1 and 

close the dialog box. 

 

 

 

 

 

 

7. Play back the animation to see if the vehicle duly reaches the road as shown below.  
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Perform analysis on straight driving 

To create torque for the vehicle, change the target velocity defined by PV.  

Changing velocity PV 

1. On the SubEntity tab, click PV in the Parameter group. 

2. In the PV List dialog box, change InputV_kmph to 40. 

3. Click OK. 

 

Perform analysis on straight driving 

1. In the Simulation Type group on the 

Analysis tab, click Dyn/Kin to open the 

Dynamic/Kinematic dialog box. 

2. On the General tab, values are defined as 

follows.  

▪ End Time: 8 

▪ Step: 160 

3. Click Simulate to proceed with the analysis.  

4. Play back the animation to see if the vehicle drives straight as shown below. 

5. Since the steering motion is fixed, the vehicle will travel straight at 40km/h. 
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Analyze J-Turn driving 

During drving, control the steering to analyze the J-Turn driving. 

Modifying the Expression of Steering 

1. On the SubEntity tab, click Expression in the Expression group. 

2. When the Expression List dialog box appears, click E in the list to modify 

Ex_Steering_RackBar_mm. 

3. When the Expression dialog box appears, modify the Content as shown below. 

▪ Content:  

▪ Step(Time-5,0,0,0.5,50) - Step(Time-7.5,0,0,0.5,50) 

 

4. The Expression defined above is a formula to 

move the RackBar by 50mm between 5 and 8 

seconds and undo the moving. When the 

RackBar moves 50mm, the Tire will turn about 

12 degrees. 

 

5. Click OK in the Expression dialog box.  

6. Click OK in the Expression List dialog box. 

 

Analyze J-Turn driving 

1. In the Simulation Type group on the Analysis tab, click Dyn/Kin to open the 

Dynamic/Kinematic dialog box. 

2. On the General tab, values are defined as follows.  

▪ End Time: 10 

▪ Step: 200 

3. Click Simulate to proceed with the analysis.  

4. Play back the animation to see if the vehicle performs J-Turn driving as shown below. 
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The result of animation analysis can be played back inside the subsystem as well. When 

played back inside the subsystem, it is played based on the Mother Body. 

Watching an animation by using the subsystem 

1. In the database, right-click Suspension Subsystem and click Edit in the pop-up menu. 

2. In the database, again, right-click Suspension_FR Subsystem and click Edit in the 

pop-up menu. 

 

3. Play back the animation to observe the behavior of the suspension. 

4. The animation is played back based on the movement of Chassis, which is the mother 

body of the subsystem. Therefore, the Suspension connected to the Chassis is seen as a 

fixed state. 
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Drawing a plot 

Draw a plot to see the dynamic behavior of a vehicle driving J-Turn. 

Drawing a plot for J-Turn analysis 

1. In the Plot group on the Analysis tab, click Result. 

2. Enter the Plot Window. 

 

3. In the Windows group on the Home tab, click All. 

4. Use the information below to draw a plot. 

▪ Top left Window: Bodies/Chassis/Vel_TM 

▪ Top right Window: Bodies/Chassis/Pos_ROLL 

▪ Bottom left Window: Tire/GTire_FLForce/FyW_Lateral 

▪ Bottom right Window: 

▪ AxisX: Bodies/Chassis/Pos_TX  

▪ AxisY: Bodies/Chassis/Pos_TY 

 

The result of plot analysis shows that the vehicle travels at a constant speed after 3.4 

seconds. You can also see that when you start J-Turn after 5 seconds, the roll angle of the 

vehicle and the lateral force of tires occur. Finally, you can see the turning behavior of the 

vehicle numerically by X-Y position information. 

  

FzW_Vertical Vel_TM 

Pos_ROLL 
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Create and apply a plot template to repeat the same plot easily. 

Exporting plot template 

1. With four curves drawn, click Template in the Export group on the Home tab.  

2. When the Export Plot Template Setting dialog box appears, click Export to save the 

template file. 

 

Connecting the plot template file 

1. Return to the modeling Window. 

2. In the Plot group on the Analysis tab, click Template.  

3. When the Template dialog box appears, turn on the Use the Default Template 

File(*.template) option. 

4. Select Use the Specified File and connect the Plot Template file created above. 

 

5. Click OK to close the dialog box. 

6. When the Plot Template is connected, the Template 

icon becomes active as shown on the right.  
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Modification and analysis of Tire 

Property 

Task Objectives 

After modifying the contact property of UA-Tire, perform the analysis of driving. Try to 

understand the impact of parameter change through the plot analysis of analysis results. 

Estimated Time to complete this task 

10 minutes 

  

Chapter 

5 
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Modification and analysis of UA-Tire Property 

There are several parameters in the Tire file that affect behaviors. Especially, during the J-

Turn driving, the behaviors are greatly affected by the lateral force applied to the side of the 

Tire. Modify the parameters that affect the lateral force and try the same analysis. 

Implement the analysis after modifying the UA-Tire Property 

1. Open the Property dialog box of GTire_FR in 

the database.  

2. Click Edit to open the UATire_MMKS.tir file. 

 

 

3. The file of UA Tire opens as a text format in 

Notepad as shown below.  

4. Edit LATERAL_STIFFNESS as 30000. 

 

5. In the File menu of Notepad, click Save to close Notepad. 

6. Again, click OK in the Property dialog box of GTire_FR. 

7. Since the four GTire properties share the same Tire file, your action affects all the 

others.  

Tip: Tip: Editing Tire Property directly with a text editor 

You can also edit the Tire file directly by opening it in a text editor on the Windows Explorer 

without having to open it in the GTire Property dialog box. The Property value thus edited is 

applied and then analysis is performed. 
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8. In the Simulation Type group on the Analysis tab, click Dyn/Kin to open the 

Dynamic/Kinematic dialog box. 

9. Click Simulate to proceed with the analysis. 

10. Once the analysis is completed, click Add in the Plot group on the Analysis tab.  

11. Since the Plot Template has been defined in Chapter 4, curves of newly analyzed results 

are drawn in the same form over the previously drawn Plot. 

 

12. If you analyze the plot results, the Lateral Force becomes smaller after lowering 

LATERAL_STIFFNESS to 30000. So, the vehicle is pushed outward in the direction of 

turn. You can also see that the roll angle of the chassis becomes smaller during the turn 

between 5 seconds and 8 seconds. 
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13. Repeat steps 1-8 by using the information below. 

▪ LATERAL_STIFFNESS: 100000 

14. Curves of newly analyzed results are drawn additionally over the previous plot. 

 

15. If you analyze the plot result again, raising LATERAL_STIFFNESS to 100000 

increases the lateral force as opposed to the previous result. So, the vehicle is pulled 

inward in the direction of turn. You can also see that the roll angle of the chassis 

becomes larger during the turn between 5 seconds and 8 seconds. Because of this 

change, the amplitude of the roll becomes very large immediately after the turn, that is, 

after 8 seconds. 
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Change and analysis of GRoad 

Task Objectives 

After changing GRoad, perform the analysis of driving.  

Estimated Time to complete this task 

10 minutes 

  

Chapter 

6 
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Change and analysis of GRoad 

Analyze the behavior of vehicle during a straight driving while changing the ground.  

Changing velocity PV 

1. On the SubEntity tab, click PV in the Parameter group. 

2. In the PV List dialog box, change InputV_kmph to 30. 

3. Click OK. 

 

Modifying the Steering Expression for straight driving 

1. On the SubEntity tab, click Expression in the Expression group. 

2. When the Expression List dialog box appears, click E in the list to modify 

Ex_Steering_RackBar_mm. 

3. When the Expression dialog box appears, modify the Content to 0. 

4. Click OK in the Expression dialog box.  

5. Click OK in the Expression List dialog box. 

 

Modifying the UA-Tire Property 

1. Open the Property dialog box of GTire_FR in 

the database.  

2. Click Edit to open the UATire_MMKS.tir file. 

3. Edit LATERAL_STIFFNESS as 50000. 
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Create GRoad by loading the ground information file provided in this tutorial. 

Copying GRoad files 

▪ Copy the GRoad_Rough.rdf file and the GRoad_Hill.rdf file from the GTire tutorial 

folder and paste it into where the model is saved.  

▪ (File path: <InstallDir> /Help/Tutorial/Toolkit/Tire/DrivingJTurn/GRoad_Hill.rdf) 

 

Analyzing after changing to rough GRoad 

1. To enter the Edit mode of the Ground, click Ground in the Marker and Body group on 

the Professional tab. 

2. When you enter Ground Edit mode, it will appear as Ground@Driving_Test in the 

upper left corner of the Working Window. 

3. Delete Box1 and GRoad1 from the database. 

4. In the Road Data group on the Ground tab, click GRImport to import 

GRoad_Rough.rdf copied above. 

 

5. GRoad1 is recreated in the database, and the rough surface is shown as below. 

 

 

6. Click Exit on the Ground tab to exit the 

Ground Edit mode.  

7. In the Property dialog box for four GTires, 

enter Road name as Ground.GRoad1. 
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8. In the Simulation Type group on the Analysis tab, click Dyn/Kin to open the 

Dynamic/Kinematic dialog box. 

9. On the General tab, values are defined as follows.  

▪ End Time: 10 

▪ Step: 1000 

10. Click Simulate to proceed with the analysis. 

11. Play back the animation to check the behavior of the vehicle. You can see the vehicle 

sway back and forth due to the rough ground. 
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Unlink the Plot Template File 

1. In the Plot group on the Analysis tab, click Template.  

2. When the Template dialog box appears, turn off the Use the Default Template 

File(*.template) option. 

3. Click OK to close the dialog box. 

 

Drawing a Plot for rough surface analysis 

1. In the Plot group on the Analysis tab, click Result.  

2. Enter the Plot Window. 

3. Use the information below to draw the vehicle's Pitch 

information. 

▪ Bodies/Chassis/Pos_PITCH 

 

 

As you saw in the animation, you can also see on the plot numerically that the pitch angle 

increases due to the irregular ground surface. 

 

  

Pos_PITCH 
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Analyzing after changing to GRoad with hills 

▪ In the same way as before, delete the existing GRoad in the Edit mode of Ground and 

then open GRoad_Hill.rdf and try the same analysis. 

 

 

Various analyses of driving (reference) 

You can think about additional driving analyses by considering several factors as follows: 

▪ Modify other properties than LATERAL_STIFFNESS and then drive 

▪ Using various geometries to change the GRoad and then drive 

▪ Change Input Velocity and Steering and then drive 

▪ Change spring property of Suspension and then drive 

 

 

 

Thanks for participating in this tutorial 


	Driving J-Turn Tutorial (Tire)
	Overview
	Task Objectives
	Prerequisites
	Task
	Estimated Time to Complete this Task

	Setting up the simulation environment
	Task Objectives
	Estimated Time to complete this task
	Start RecurDyn
	Creating a new model

	Resizing icons and markers
	Changing the size of icons and markers


	Vehicle modeling
	Task Objectives
	Estimated Time to complete this task 15 minutes
	Estimated Time to complete this task 15 minutes
	Creation of Chassis Body
	Creating Chassis Geometry
	Changing the property of Body1

	Creation of Suspension Subsystem
	Loading Suspension Subsystem
	Changing Subsystem Mother Body

	Create Translate Joint for Steering
	Creating Translate Joint
	Entering Motion in the Translate Joint

	Creation of Rotational Axial Force for Power
	Creation of Rotational Axial Force
	To save the model

	Creation of GRoad
	Creating Box Geometry for creation of GRoad
	Creating GRoad

	Creation of GTire
	Copying UA-Tire type Tire file
	Creating GTire
	Creating a Fixed Joint between GTire and WheelHub
	To save the model


	Analysis of driving
	Task Objectives
	Estimated Time to complete this task
	Preparation for the analysis of driving
	Define the Torque of running speed as Spline
	Defining PV
	Creating Reference Marker to measure vehicle speed
	Defining Torque Expression
	Entering Torque Expression

	Implement the analysis of vehicle’s settling on the road
	Implement the analysis of vehicle landing

	Perform analysis on straight driving
	Changing velocity PV
	Perform analysis on straight driving

	Analyze J-Turn driving
	Modifying the Expression of Steering
	Analyze J-Turn driving
	Watching an animation by using the subsystem

	Drawing a plot
	Drawing a plot for J-Turn analysis
	Exporting plot template
	Connecting the plot template file


	Modification and analysis of Tire Property
	Task Objectives
	Estimated Time to complete this task
	Modification and analysis of UA-Tire Property
	Implement the analysis after modifying the UA-Tire Property


	Change and analysis of GRoad
	Task Objectives
	Estimated Time to complete this task
	Change and analysis of GRoad
	Changing velocity PV
	Modifying the Steering Expression for straight driving
	Modifying the UA-Tire Property
	Copying GRoad files
	Analyzing after changing to rough GRoad
	Unlink the Plot Template File
	Drawing a Plot for rough surface analysis
	Analyzing after changing to GRoad with hills

	Various analyses of driving (reference)



